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Lesson 1 
 

Lesson 1: Introducing 
QuickBooks  

Lesson Objectives 
After studying this lesson, you will be able to: 

 determine which edition would be right for your company 

 manage basic QuickBooks company files 

 open and restore company files 

 work with the QuickBooks window 

 find Help in QuickBooks  

 update a company file 

 backup and close a company file 

What’s New in QuickBooks 2012 
Intuit Canada introduces a new version of QuickBooks annually, with either new or improved features. This is a 

list of the new features to be found in QuickBooks 2012.  

 New Calendar view shows invoices, billing and other important tasks. The improved “to-do” list captures 

more relevant information and displays it all in a calendar format. 

 Customer Snapshot provides a consolidated view of the business, and shows at a glance a customer’s 

purchase history, average days to pay and any outstanding balance. 

 Batch invoicing allows invoicing of multiple customers using the same service at once. Simply create the 

invoice once and select the customers to send it to. 

 Collection Centre enables a company to manage receivables. This option quickly identifies overdue and 

almost due invoices, and allows email notices from Outlook, Yahoo, Gmail, or Hotmail in a few steps. 

 Improved QuickBooks Search. Enter a keyword, and this option will display all the related reports, invoices, 

contacts, and transaction details. 

 Sending invoices and estimates from the business Yahoo, Gmail or Hotmail Account. The new Webmail 

integration allows emailing from QuickBooks without setting up Outlook. 

 Batched Timesheets for multiple employees or vendors. Create and use the same timesheet for 

employees or vendors who worked the same hours. 

 Sort balance sheets by class, location or profit centre. Not available in Pro or Easy Start. 

 New Setup Wizard – includes coaching tips to help navigate through the first tasks in minutes. 
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General QuickBooks Knowledge 
QuickBooks Versions 

As stated above, Intuit creates a new version annually, and each new version provides additional features that 

are new for that version. Within each version, several editions are available; in QuickBooks 2012 there is also 

an online edition that, for a monthly fee, allows access to company QuickBooks files via the Internet.  

QuickBooks Editions 
QuickBooks provides several editions, all of which perform the basic tasks required for small-business 

bookkeeping. It is wise to evaluate just what you need QuickBooks to do for your business before you decide 

which edition to purchase. The following is a list of the editions available in QuickBooks 2012: 

 Premier Edition (General Business) 

 Accountant Edition 

 Contractor Edition 

 Manufacturing & Wholesale Edition 

 Nonprofit Edition 

 Professional Services Edition 

 Retail Edition 

 QuickBooks Pro 

 QuickBooks Easy Start 

 

QuickBooks Online Edition 
The online edition looks very similar to the traditional desktop editions but has some unique features: 

 Automatic online backups 

 Users in multiple or remote locations can access a single file. 

 QuickBooks can be accessed from any computer with Internet access, as well as from some smart 

phones. 

This manual has been created using QuickBooks Premier 2012. Please note that if you are using a different 

edition your screen may look slightly different from those displayed in this book.  

To determine which edition you are using follow these steps: 

1. Click File from the menu bar. 

2. Select Toggle to Another Edition from the drop-down menu. 

3. View the list of editions available – the one currently in use will be indicated. 
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Managing QuickBooks Files 
Understanding some basic file management tasks will allow you to work more effectively in the QuickBooks 

environment. This section will show you how to start the program, open and restore files, and understand the 

basic types of files. 

Starting QuickBooks  
There is always more than one way to do things on a computer, and starting QuickBooks is no exception. Ask 

your instructor the preferred method of starting QuickBooks in the computer lab where you are working. There 

may be a shortcut on the desktop, or you may have to go through the All Programs menu which can be 

accessed by the Start button.  

QuickBooks Files 
QuickBooks data can be stored in three different types of files: company files, backup files and portable 

company files. A company file is the type in which you will work with your business (extension .qbw). A backup 

file (extension .qbb) is used to store a copy of your file and can be used to restore the file if the main company 

file is corrupted. A portable company file (extension .qbm) is much smaller than either of the other two, and can 

be used to send your information by email. The company file can be stored anywhere on your computer, but it 

is recommended that you also store a backup or portable file on either an external hard drive, or flash drive 

kept in a safe place. With the QuickBooks online edition, the file can be stored online. 

While these three types are the ones most frequently worked with, there are two other support type files in 

QuickBooks. A network data file (extension .nd) contains important configuration data. A transaction log file 

(extension .tlg) can help recover any data entered after the last backup operation that was performed. 

These two types of files do not store company data, but provide important support for the other three types. It is 

important to understand their roles, and NOT to delete them as they may affect the integrity of your company 

data. 

Opening and Restoring QuickBooks Files 
The command to open or restore a company file is accessed from the File menu. This command will display the 

following window, which allows you to choose which type of file to open.  

  

To Open a company file proceed as follows: 

1. Choose File, Open or Restore Company from the menu bar. 

2. Choose Open a company file, click Next. 

3. Navigate to the file location, select the desired file, click Open. 

   OR 

1. Choose File, Open Previous Company. 

2. Select the desired file from the drop-down list by clicking on it.   

2.2 
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To Restore a company file proceed as follows: 

1. Choose File, Open or Restore Company from the menu bar. 

2. Choose Restore a backup copy, click Next. 

3. Choose Local backup, click Next. 

4. Navigate to the file location, click Next. 

5. Locate the backup file you wish to restore, and then click Open. 

6. Click Next, choose the location to save the restored file, and then click Save. 

 

Learn the Skill 
In this exercise you will start QuickBooks, and then restore a QuickBooks backup file. 

1. Click the Start button, select All Programs, click QuickBooks, and then 

QuickBooks Premier 2012.  

 A window will appear that displays the version of QuickBooks you are starting and 

opens the window. 

2. Choose File from the menu bar, and then Open or Restore Company. 

3. Select Restore a backup copy. 

  

4. Click Next. 

5. Select Local backup and click Next. 

6. Navigate to the file storage location selected when you downloaded the student files for this book. 

  

7. Select the Sample_Pro Hockey School backup file, and then click Open. 

8. Read the information in the Open or Restore Company window, Click Next. 

9. Choose the location to restore the file, as directed by your instructor. 

10. Change the file name to Your Name Pro Hockey School (e.g. Gerry’s Pro Hockey School). 

11. Click Save. 

12. Click OK in both the QuickBooks information windows. 

  

Note… 
A similar procedure 
would be followed to 
restore a portable file. 

Note… 
You can also open 
QuickBooks from a 
desktop icon. 

Note…
It may take a few moments for the file to open. 
When it does, it will open with the Sample Pro 
Hockey School company file fully operational. Fo
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The QuickBooks Window 

This is the screen displayed when QuickBooks opens a company file.  

The Title bar displays the company name, and the version/edition of QuickBooks that you are using. 

 Buttons on the menu bar will display drop-down menus when clicked on. 

   The icon bar contains icons for fast access to activities, centres and lists  

 

Control Icon Located in the top left corner, this displays the Control Menu box to select such 

options as Restore, Move, Size, Maximize, Minimize, and Close. These are standard 

Windows options available on most Control Menus. 

Title Bar Located at the top of a window, the title bar displays the name of the currently active 

company data file, e.g., Sample Pro Hockey School., followed by the name of the 

selected application (QuickBooks Premier Edition). 

Minimize, 

Maximize/Restore 

or Close Buttons 

Located in the top right corner of a window, these buttons control a window’s display 

size. Use the  (Minimize) button to minimize the QuickBooks window to the 

taskbar,  (Maximize) to full screen,  (Restore Down) to the original window 

size, or  (Close) the program completely. 

Menu Bar Located below the title bar, this bar provides access to the main menu commands (i.e., 

File, Edit, View, etc.) which, when displayed, contain different sets of commands to 

activate features or options. 

2.1 
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Icon Bar Located below the menu bar, these buttons are used as a shortcut icon to the relative 

window. For instance, clicking on the Customer Centre icon will open the Customer 

Centre window. Place the mouse pointer over the icon to display the icon’s function. 

 

Home Page This window displays sections for the various company areas such as Vendors, 

Customers, etc., each of which contain icons for features used in each area.  

Vendors Section Contains icons for transactions such as: Purchase Orders, Enter Bills & Vendor Credits, 

Receive Inventory, Enter Bills Against Inventory, Pay Bills, Manage Sales Tax. 

Customers 

Section 

Contains icons for transactions such as: Sales Orders, Estimates, Create Invoices, 

Enter Daily Sales, Receive Payments, Statements, Refunds & Credits. 

Employees 

Section 

Contains icons for: Payroll Centre, Enter Time, Pay Employees, Pay Liabilities, Process 

Payroll Forms. 

Company Section Contains icons for: Chart of Accounts, Items & Services, Inventory Activities (which 

includes Build Assemblies & Adjust Quantity/Value on Hand), and Calendar.  

Banking Section Contains icons for: Record Deposits, Write Cheques, Print Cheques, Reconcile 

accounts, Cheque Register, and Enter Credit Card Charges. 

Getting Started This section contains icons for the “Quick Start Centre”, and “Setup and Training”, as 

well as quick access to Account Balances, Do More with QuickBooks, and Reminders & 

Alerts. 

 

Using the QuickBooks Menus 
The QuickBooks menus not only display the menu choice, but additionally provide a keyboard shortcut beside 

many of the menu commands. An ellipsis (…) at the end of a menu option indicates a dialog box will appear 

when you select this command. 

To access a menu item: 

1. Using the mouse: 

 a. Click on the menu item in the menu bar.  

 b. Click to select the desired command from the sub menu. 

2. Using keyboard controls 

 a. Press  or  to activate keyboard controls. 

 b. Use  or  to move the cursor to desired menu. 

 c. Use  to make the selection from the submenu. 

 d. Press . 

If a menu is displayed and you no longer need it, use one of the following methods to close the menu: 

 Click in a blank area away from the menu. 

 Press  to close the menu, and then press  once more to deselect the menu bar.  

 

Note… 
If you have arranged for online access to your QuickBooks data, the QuickBooks Connect icon will be displayed in the 
Company section. 

Note… 
Any menu item in black on the 
menu bar means that particular 
item is active; a menu item in grey 
indicates the feature is unavailable 
at this time. 
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Using the QuickBooks Icon Bar 

The Icon bar contains buttons you can access using the mouse. These buttons provide shortcuts for accessing 

many QuickBooks features. When you place the mouse cursor over a button in the Icon bar, it will change 

colour and a ScreenTip appears to identify the purpose of the button. Many of the menu items appear as 

buttons on the Icon bar to enable you to use QuickBooks more quickly and efficiently. To choose a button on 

the Icon bar, click it with the left mouse button. The icons displayed in the Icon bar will depend on the type of 

company currently being used and may vary from the sample displayed below. 

 

 

Learn the Skill 
In this exercise you will open and close windows from the Icon bar. 

1. Click the Customers icon to open the Customer Centre.  

2. Click Matthew Downs to review the customer information provided.  

3. Close the Customer Centre window. 

4. Repeat the first three steps for Vendors, selecting the file for Blitz Marketing. 

5. Ensure both windows are closed. 

Understanding the Workflow 
The Home Page contains workflow diagrams in the Vendors, Customers and Employees sections that are 

depicted by the arrows between icons. Pointing your mouse over an icon will result in a description of what task 

the icon will access. Clicking on an icon will cause QuickBooks to display the required dialog box for the task. 

 

 

 

 

A dialog box is a window that appears when QuickBooks offers additional options or requires more information 

from you before carrying out a command. You can use either the mouse or keyboard to access the commands 

available in a dialog box. 

  

Fo
r E

va
lua

tio
n O

nly



 

Lesson 1  Introducing QuickBooks 
 

 8  1712-1 v1.00 © CCI Learning Solutions Inc. 

It is important to follow the workflow as depicted on the home page to avoid trouble. For instance: 

 If you use Write Cheque to pay a bill that has been entered as a payable you will overstate expenses, and 

will not clear the transaction originally entered using Enter Bills. 

 If you make a deposit rather than “Receive a Payment” for an invoiced amount, you will overstate income 

and will not clear the original entry. 

Following the workflow illustrated on the Home page can also help you avoid Sales Tax errors. 

 

Learn the Skill 
In this exercise, you will open several windows and use the Open Window List to switch between 
windows. 

1. Click the Customers icon, and leave the window open 

2. Click the Vendors icon, and leave the window open 

3. Click the Employees icon, and leave the window open 

4. Click View from the menu bar 

  

5. Select Open Window List.  

 The open windows list is then displayed on the left side of the screen, and lists all open windows. 

  

6. Select Customer Centre from the list to view that window. Note that it now becomes the first item in the 

list. Close the Customer Centre window. 

7. Repeat these steps for the Employee Centre, and then the Vendor Centre. 

8. Close the Open Windows list. 
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Finding Help in QuickBooks  
To open the Help window, click on Help in the menu bar. QuickBooks has a full-featured Help system to get 

you the information you need. To get help from anywhere within QuickBooks, press . 

 

 

You can also enter a search term at 

the top of the Help window, which is 

accessed by selecting Help from 

the menu bar and then 

QuickBooks Help. 

The Back button allows a return to 

the previous help topic viewed. 

The Print Topic button allows you to 
print the help topic you are currently 
viewing. 

  

The Have a Question? window, displayed to the right of the main window provides two tabs to search for help. 

Help Tab This has a field in which you can type a specific keyword to search for help on that topic. 

Live 

Community Tab 

This tab provides access to an online community where you can view questions that have 

been answered by other users, and to ask your own questions of other users. 

There are a variety of ways to access QuickBooks help: 

 Visit the QuickBooks support site to search in-depth support articles or get help from a QuickBooks 

Support Representative. 

 Visit the Intuit Community to connect with other Intuit users and small business owners. 

 Watch the Learning Centre tutorials.  

- The Learning Centre Tutorials give you a "big picture" overview of important concepts in 

QuickBooks, as well as step-by-step instructions for key tasks. 

- To watch the Learning Centre Tutorials, choose Help > Learning Centre Tutorials. 

 Learn about training solutions to help you use and customize QuickBooks for your business. 

 Find a local QuickBooks expert. 
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Learn the Skill 
In this exercise, you will work with QuickBooks Help. 

1. Click Customers in the icon bar to open the Customer Centre window. 

2. Click anywhere in the open window and then press . 

 The Help window opens. 

3. Click Customer Centre overview, and read the information provided. 

4. Close the Customer Centre window. 

5. With the Have a Question? window still open, click the Search button in the Help tab. 

6. In the search field at the top of the window, type: Chart of Accounts, and then click the arrow. 

7. From the list of topics found, select the first topic, Understand your chart of accounts. 

8. Review the information provided, and then close the Help window. 

Updating QuickBooks  
We have already discussed the different versions and editions of QuickBooks that are available each year. In 

addition, QuickBooks releases free updates for the software throughout the life of the version. As versions age, 

QuickBooks will eventually advise they will no longer support older versions, depending on the length of time 

since its release.  

The updates may include the launch of a new service, a maintenance release, a tax table update, etc. To keep 

up to date easily, you can have QuickBooks check automatically for updates and download them through the 

Automatic Update feature. 

To activate this feature:  

1. Click on Help from the menu bar 

2. Select Update QuickBooks from the drop-down menu. 

3. On the Options tab, ensure the Yes button for Automatic Update is selected. 

4. Click Close. 

Verifying the Release Number 
To verify the release number of your software, press the  key. This will open a window that displays the 

release, as well as other information about your QuickBooks program including the license number, product 

number, Payroll information, for instance.  

Backing Up and Closing Files 
Backups should be done every time you complete a work session where you have made changes of any sort to 

the QuickBooks data. The importance of backups cannot be over-emphasized. Hard disk drives can crash and 

data files can become corrupted. Imagine having to re-enter a whole year’s work because a backup wasn’t 

done—it has happened! If you back up the file regularly, and are forced to restore the file from the backup copy, 

you will only have to re-enter those transactions occurring since the last backup. 
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Using QuickBooks Backup allows you to stay with the original file as opposed to using Create a copy, which 

saves the data as a new file (Portable or Accountant’s). QuickBooks contains a feature to schedule regular 

backups. Remember also that QuickBooks automatically saves transactions to the company file as you enter 

them, therefore, the backup process will save all the current information. For more information, search “back 

up” in the Help Index, and select the topic Schedule Backups. 

Portable Copy 
A portable company file is a compact version of your company file containing only financial data, and is small 

enough to be sent by email or saved to portable media. You can use a portable company file whenever you 

need to move your company financial data to another location or send it to another person. Note, however, that 

it takes several minutes for the program to restore a portable file, as it must then recreate all the other data 

before opening the file. 

Accountant Copy 
An Accountant Copy is a version of your company file your accountant can use to make changes while you 

continue to work. When your accountant is done, you can then import his or her changes into your company 

file. Create an Accountant Copy file and deliver it to your accountant (email, CD, or other method). Before you 

begin, coordinate with your accountant on a dividing date. This date defines the fiscal period your accountant 

will work on. 

Backup Location 
With today’s new technology, a backup is best done using a DVD disc, CD disc or USB flash drive, and stored 

away from the company’s location. Although no storage media are guaranteed to preserve their contents for a 

very long period of time, these types are considered to be quite reliable. For the duration of this course, it is 

recommended that you have a flash drive to store all the data files you will be working with. 

Online Options 
QuickBooks 2012 is now fully integrated for online backup. For a monthly fee which is determined by the 

storage space required for your data, this service offers a schedule of automatic or manual backups. Uploaded 

files are encrypted and filed in a remote location that can be accessed from anywhere via the internet. To learn 

more about this option you can click Learn more about QuickBooks Online Backup in the Create Backup 

window. 

 

Learn the Skill 
In this exercise you will create a backup copy of the Sample Pro Hockey School file. This exercise uses 
the C:\ drive for demonstration purposes only, but it is recommended that you use a flash drive to back up 
all the data files used in this manual. 

1. Click File from the menu bar and then select Create Backup. 
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2. Click to select Local backup, and then click Next. 

3. In the Backup Options window, browse to the location of your flash drive. 

 

Note that the C: drive is illustrated 

here for demonstration purposes 

only, your screen should show the 

location of the flash drive. 

Choose the number of files to be 

saved in this location. 

It is recommended that you verify 

the file is not corrupted. 

 

 

Choose the frequency of your 

backups. 

 

4. When you have completed the Backup Options window, click OK. 

5. The following three options will be displayed in the Create Backup window: 

  a. Save it now 

  b. Save it now and schedule future backups 

  c. Only schedule future backups 

6. Select Save it now and click Next 

7. Accept the suggested file name and click Save. 

8. When the backup process is completed successfully, QuickBooks will display an information window 

confirming the backup, the location, and the file name. Click OK. 

9. If you wish to close this company file, click the close icon to the far right of the home page  

  

Exiting QuickBooks  
As mentioned before, it is recommended that you backup the company file before exiting QuickBooks. Now that 

we have backed up the Sample_Pro Hockey School file, we can exit QuickBooks with the knowledge that the 

file has been saved as a backup. If we did not backup the file, we can still exit QuickBooks, and the file will be 

reopened when we open QuickBooks again.  

 If you wish to continue on with the next exercise(s) leave QuickBooks open. 

Note… 
It is recommended that you add the date of the backup to the filename. This allows you to keep multiple versions of the backup 
file in the same location—if you encounter problems with your most recent backup, then you can select an older backup version. 
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 If you are finished working for now, you can exit QuickBooks by choosing File, Exit from the menu bar.  

Lesson Summary 
In this lesson, you learned about the basic functions and features of QuickBooks Premium. In particular, you 

learned how to: 

 determine which edition would be right for your company 

 manage basic QuickBooks company files 

 open and restore company files 

 work with the QuickBooks window 

 find help in QuickBooks  

 update a company file 

 backup and close a company file 

Review Questions 
1. QuickBooks offers several editions tailored to small business operations. 

a. True b. False 

2. How would you open the Customer Centre? 

a. Click the Customers icon in the customers section of the home page 

b. Click the Customers icon on the Icon bar 

c. Click Customers in the menu bar, then Customer Centre 

d. All of the above. 

3. In the event of data loss, what type of file helps you recover any data entered after the last backup 

operation?  

a. Backup File c. Portable File 

b. Network Data File  d. Transaction Log File 

4. List three of the five sections viewed on the Home Page. 

 _________________________________________________________________________________ 

5. Where would you find the name of the company file in which you are working?  

a. Menu bar c. Title bar 

b. Icon bar d. All of the above 
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Develop Your Skills 
In the Develop Your Skills exercises throughout this manual, you will be working with a company by the 
name of Lakeview Bed & Breakfast. This business provides accommodation services.The hosts are Jack 
and Susie Black, and the business is a sole proprietorship. You willl be helping Jack with a variety of 
QuickBooks tasks as you proceed through the manual. 

Reviewing a QuickBooks file.  

In this exercise you will review the QuickBooks file that Jack has been working in. To start you will open a 

backup company file. 

Restoring a Backup Company File 

1. If necessary, start QuickBooks  

2. Click File, Open or Restore Company from the menu bar. 

3. Select Restore backup copy, and then click Next. 

4. Select Local backup, and click Next. 

5. Navigate to the file storage location to select the Lakeview Bed & Breakfast backup file 

  

6. Select the file and click Open, or double-click the filename to proceed to the next step. 

7. Click Next, and select the file location where you wish to store the file. 

8. Adjust the file name to read: Your Name Bed & Breakfast (e.g. Mary’s Bed & Breakfast). 

9. Click Save, and then OK in the QuickBooks information window. 

Exploring the Company File 

1. Use the following methods to open the Item list, closing the list after each method.  

a. Click Lists, Item List from the menu bar. Review the entries displayed in the Item List window, close 

the list.  

b. Click on the Items & Services icon in the Company section of the Home 

page, close the list. 

c. Select Vendors from the menu bar, and then Item List, close the list. 

2. Click the Customers icon on the icon bar. Review the customer list. 

3. Select Larry K. Smith and review the customer information provided. 

4. Select Vendors, Pay Bills from the menu bar. Review the vendor information in the Pay Bills window 

5. Click View, Open Window List from the menu bar. 

  

6. Click on Customer Centre: Larry K.Smith (All Transactions) to make it the active window.  

7. Close the Open Windows list, and then click on Window, Close All from the menu bar. 
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8. Click the Home icon on the icon bar to reopen the Home page. 

Proceed as follows: Backup the company file as Your Name Bed & Breakfast – lesson 1 and then: 

 If you wish to continue on with the next exercise(s) leave QuickBooks open. 

 If you are finished working for now, you can exit QuickBooks by choosing File, Exit from the menu bar.  

 

Apply Your Skills 
In the Apply Your Skills exercises throughout this manual, you will be working with a company by the 
name of Dogwood Lawn & Tree Services. This business provides landscaping and tree services.The 
owner is Darren Reid and the business is a sole proprietorship. 

Restore a QuickBooks backup file 

You will open a backup file of Darren’s company, and review the file. 

1. If necessary start QuickBooks and restore the backup file for Dogwood Lawn & Tree Services.  

2. Save the file as Your Name Lawn & Tree Services. 

3. Close the QuickBooks Learning Centre window. 

4. Using any of the methods discussed in this lesson, open the following windows: 

a. Vendor Centre 

b. Item List 

c. Chart of Accounts 

d. Write Cheques 

e. Create Invoices 

f. Reminders list 

5. Display the Write Cheques window above the other open windows. 

6. Close all windows exept the Vendor Centre. 

7. Select Colstream Nursery and review the information provided. 

8. Close the Vendor Centre. 

9. Backup the company file as Your Name Lawn & Tree Services‐ lesson 1. 

10. Exit QuickBooks. 
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